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Introduction

Only a few years ago, PowerPoint was a novelty. Then, all of a sudden, 
speakers started giving PowerPoint presentations at conferences and 

seminars. Audiences welcomed PowerPoint. The slides made presentations 
more interesting and lively. You could gaze at the slides while you listened 
to the speaker. Speakers — especially speakers who weren’t comfortable 
talking before an audience — liked PowerPoint, too. PowerPoint took away 
some of the burdens of public speaking. The program made it easier to 
speak in front of strangers.

PowerPoint became a staple of conferences, seminars, and corporate board-
rooms. Then the novelty wore off, and audiences started grumbling. The 
presentations were too much alike. You saw bulleted list after bulleted list. 
Presentations followed the same tired formula — introductory slides fol-
lowed by “key point” slides following by a tidy conclusion. Writing in the New 
Yorker, Ian Parker declared that PowerPoint is “a social instrument, turning 
middle managers into bullet-point dandies.” Edward Tufte, professor of infor-
mation design at Yale University, lamented the program’s “charjunk” and 
“PowerPointPhluff.” In a Wired essay called “PowerPoint Is Evil,” he wrote, 
“PowerPoint style routinely disrupts, dominates, and trivializes content.”

Despite these complaints, speakers have not abandoned PowerPoint, and 
audiences still welcome it. But expectations have risen. Audiences expect 
the presenter to use PowerPoint skillfully and creatively. The audience 
knows when a presenter is just going through the motions and when a pre-
senter is using PowerPoint to explore a subject and show it in a new light.

This book was written with the goal of showing you how to use the 
PowerPoint software, but also how to use it with skill and imagination. I 
tell you which buttons to click to complete tasks, but I also show you how 
PowerPoint can be a means of communicating and connecting with your 
audience. I show you how to build a persuasive presentation, one that 
brings the audience around to your side. No matter how much experience 
you have with PowerPoint, this book will make you a better, more profi-
cient, more confident user of the program.

What’s in This Book, Anyway?
This book is jam-packed with how-to’s, advice, shortcuts, and tips for getting 
the most out of PowerPoint. Here’s a bare outline of the seven parts of this 
book:
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2 What Makes This Book Special

 ✦ Book I: Getting Started in PowerPoint: Explains the PowerPoint inter-
face and how to get around on-screen, as well as basic tasks such as 
how to create presentations and view presentations in different ways. 
You can also find advice for formulating and designing presentations.

 ✦ Book II: Building Your Presentation: Shows how to create, manipulate, 
and format slides, as well as how to handle the master slides and master 
styles that make it possible to format many slides simultaneously. You 
discover how to design the look of your presentation and enter lists, 
text, and text boxes.

 ✦ Book III: Communicating with Tables, Charts, and Diagrams: Explores 
the many techniques for creating, designing, and formatting tables, 
charts, and diagrams.

 ✦ Book IV: Embellishing Your Slides with Graphics and Shapes: 
Demonstrates how to create lines, shapes, text-box shapes, and WordArt 
images. You also find out how to adorn a presentation with photo-
graphs, graphics, and clip-art images.

 ✦ Book V: Flash and Dash: Shows how to take advantage of transitions and 
animations, as well as make video and sound a part of a presentation.

 ✦ Book VI: Giving a Presentation: Explores all the different ways to deliver 
a presentation — in person, as a self-running presentation, as a user-run 
presentation, and as a video. You find out how to write slide notes and 
print presentations, as well as deliver them over the Internet and on CDs.

 ✦ Book VII: PowerPoint for Power Users: Looks into customizing 
PowerPoint, designing templates, collaborating with others, linking and 
embedding, and understanding macros.

What Makes This Book Special
You are holding in your hands a computer book designed to make learning 
PowerPoint as easy and comfortable as possible. Besides the fact that this 
book is easy to read, it’s different from other books about PowerPoint.

Easy-to-look-up information
This book is a reference, and that means that readers have to be able to find 
out how to do something quickly. To that end, I have taken great pains to 
make sure that the material in this book is well organized and easy to find. 
The descriptive headings help you find information quickly. The bulleted 
and numbered lists make accomplishing a task simpler. The tables make 
options easier to understand.

I want you to be able to look down the page and see in a heading or list the 
name of the topic that concerns you. I want you to be able to find what you 
need quickly. Compare the table of contents in this book to the book next to 
it on the bookstore shelf. This book is better organized than the others.
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3Conventions Used in This Book

A task-oriented approach
Most computer books describe what the software is, but this book shows 
you how to use the software. I assume that you came to this book because 
you want to know how to do something — animate a slide, create a chart, 
design a look for your presentation. You came to the right place. This book 
shows you how to make PowerPoint work for you.

Meaningful screen shots
The screen shots in this book show only the part of the screen that illus-
trates what is being explained in the text. When an explanation refers to 
one part of the screen, only that part of the screen is shown. I took great 
care to make sure that the screen shots serve to help you understand the 
PowerPoint features and how they work.

Foolish Assumptions
Please forgive me, but I made some foolish assumptions about you, the 
reader of this book. I assumed that:

 ✦ You own a copy of PowerPoint 2010, the latest version of PowerPoint, 
and you have installed it on your computer.

 ✦ You use the Windows operating system. Even if yours is an old version 
of Windows, all the methods in this book apply.

 ✦ You are kind to foreign tourists and small animals.

Conventions Used in This Book
I want you to understand all the instructions in this book, and in that spirit, 
I’ve adopted a few conventions.

Where you see boldface letters or numbers in this book, it means to type 
the letters or numbers. For example, “Enter 25 in the Percentage text box” 
means to do exactly that: Enter the number 25.

Sometimes two tabs on the ribbon have the same name. To distinguish tabs 
with the same name from one another, I sometimes include one tab’s “Tools” 
heading in parentheses if there could be any confusion about which tab I’m 
referring to. For example, when you see the words “(Table Tools) Design 
tab,” I’m referring to the Design tab for creating tables, not the Design tab for 
changing a slide’s appearance. (Book I, Chapter 3 describes the ribbon and 
the tabs in detail.)
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4 Icons Used in This Book

To show you how to step through command sequences, I use the ➪ symbol. 
For example, you can click the File tab and choose Share➪Create a Video to 
create a video of a presentation. The ➪ symbol is just a shorthand method of 
saying “Choose Share and then choose Create a Video.”

To give most commands, you can press combinations of keys. For example, 
pressing Ctrl+S saves the file you’re working on. In other words, you can hold 
down the Ctrl key and press the S key to save a file. Where you see Ctrl+, Alt+, 
or Shift+ and a key name or key names, press the keys simultaneously.

  Yet another way to give a command is to click a button. When I tell you to 
click a button, you see a small illustration of the button in the margin of this 
book (unless the button is too large to fit in the margin). The button shown 
here is the Save button, the one you can click to save a presentation.

Icons Used in This Book
To help you get the most out of this book, I’ve placed icons here and there. 
Here’s what the icons mean:

 

Next to the Tip icon, you can find shortcuts and tricks of the trade to make 
your visit to PowerPoint Land more enjoyable.

 Where you see the Warning icon, tread softly and carefully. It means that 
you are about to do something that you may regret later.

 When I explain a juicy fact that bears remembering, I mark it with a 
Remember icon. When you see this icon, prick up your ears. You will dis-
cover something that you need to remember throughout your adventures 
with PowerPoint.

 When I am forced to describe high-tech stuff, a Technical Stuff icon appears 
in the margin. You don’t have to read what’s beside the Technical Stuff icons 
if you don’t want to, although these technical descriptions often help you 
understand how a software feature works.

Good Luck, Reader!
If you have a comment about this book, a question, or a shortcut you 
would like to share with me, send an e-mail message to me at this address: 
peterwev@gmail.com. Be advised that I usually can’t answer e-mail right 
away because I’m too darned busy. I do appreciate comments and ques-
tions, however, because they help me pass my dreary days in captivity.
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Book I

Getting Started in 
PowerPoint

04_500996-pp01.indd   504_500996-pp01.indd   5 4/19/10   10:42 AM4/19/10   10:42 AM



Contents at a Glance

Chapter 1: Introducing PowerPoint. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

PowerPoint Slides ............................................................................................ 7
Some PowerPoint Jargon ................................................................................ 9
PowerPoint as a Communication Tool ......................................................... 9
A Whirlwind Tour of PowerPoint ................................................................ 10

Chapter 2: PowerPoint Nuts and Bolts. . . . . . . . . . . . . . . . . . . . . . . . . . .15

Starting PowerPoint ...................................................................................... 15
Creating a New Presentation ........................................................................ 18
Saving Your Presentation Files .................................................................... 22
Navigating the Save As and Open Dialog Boxes ........................................ 26
Opening and Closing Presentations ............................................................ 28
Entering the Document Properties .............................................................. 30
Shortcut Commands Worth Knowing ......................................................... 31

Chapter 3: Finding Your Way around the PowerPoint Screen. . . . . . .35

A Brief Geography Lesson ............................................................................ 35
Knowing Your Way around the PowerPoint Interface .............................. 37
Zooming In, Zooming Out ............................................................................. 44
Getting a Better View of Your Work ............................................................ 45
Hiding and Displaying the Slides Pane and Notes Pane ........................... 50
Displaying, Hiding, and Reading the Ruler ................................................. 51

Chapter 4: Planning Ahead for a Solid Presentation . . . . . . . . . . . . . . .53

Formulating Your Presentation ................................................................... 54
Designing Your Presentation ....................................................................... 55
Delivering Your Presentation ....................................................................... 60

04_500996-pp01.indd   604_500996-pp01.indd   6 4/19/10   10:42 AM4/19/10   10:42 AM



Chapter 1: Introducing PowerPoint

In This Chapter
✓ Taking a peek at PowerPoint

✓ Understanding PowerPoint jargon

✓ Communicating by way of PowerPoint presentations

✓ Taking a quick tour of the program

In this short chapter, I take you to the end of a pier, briefly explain 
what swimming is, and push you in the water. As you thrash about, I 

tell you what a PowerPoint presentation is and explain some PowerPoint 
jargon. Then I fish you out of the water and take you on a whirlwind tour of 
PowerPoint. By the time you finish reading this chapter, you will know what 
creating a PowerPoint presentation entails.

PowerPoint Slides
Figure 1-1 (top) shows the PowerPoint window. That thing in the middle 
is a slide, PowerPoint’s word for an image that you show your audience. 
Surrounding the slide are many tools for entering text and decorating slides. 
When the time comes to show your slides, you dispense with the tools and 
make the slide fill the screen, as shown in Figure 1-1 (bottom). Throughout 
this book, you will find instructions for making slides and for constructing a 
presentation, the PowerPoint word that describes all the slides, from first to 
last, that you show to your audience.
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8 PowerPoint Slides

 

Figure 1-1: 
The 
PowerPoint 
window 
(top) and a 
slide as it 
looks in a 
presentation 
(bottom).
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9PowerPoint as a Communication Tool

Some PowerPoint Jargon
To make PowerPoint do your bidding, you need to know a little jargon:

 ✦ Presentation: All the slides, from start to finish, that you show 
your audience. Sometimes presentations are called “slide shows.” 
Presentations are saved in presentation files (.pptx files).

 ✦ Slides: The images you create with PowerPoint. During a presentation, 
slides appear on-screen one after the other. Don’t be put off by the word 
slide and dreary memories of sitting through your uncle’s vacation slide-
show. You don’t need a slide projector to show these slides. You can 
now plug a laptop or other computer into special monitors that display 
PowerPoint slides. (Book II, Chapter 1 describes how to create slides.)

 ✦ Notes: Printed pages that you, the speaker, write and print so that you 
know what to say during a presentation. Only the speaker sees notes. 
(Book VI, Chapter 2 explains notes.)

 ✦ Handout: Printed pages that you may give to the audience after a pre-
sentation. A handout shows the slides in the presentation. Handouts are 
also known by the somewhat derogatory term “leave-behinds.” (Book VI, 
Chapter 2 explains handouts.)

PowerPoint as a Communication Tool
PowerPoint isn’t just a speaker’s aid, but a means of communicating some-
thing to an audience — an idea, a business plan, a marketing strategy. 
PowerPoint has become so popular in part because it relieves the burden of 
public speaking. A nervous public speaker (and who isn’t a nervous public 
speaker?) can avert the attention of the audience to the slides and allow the 
slides to carry the day. But those slides in and of themselves can be great 
means of communication. PowerPoint offers numerous ways to communi-
cate with an audience above and beyond what can be said in words:

 ✦ Colors: Your color choices set the tone and suggest what you want to 
convey in your presentation. Book II, Chapter 3 explains how to choose 
colors; Book VII, Chapter 2 describes how to incorporate a company’s 
colors (and logo) in a presentation.

 ✦ Photographs and other images: A picture, they say, is worth a thou-
sand words. Spare yourself from having to speak thousands of words 
by including pictures in your presentation. Book IV, Chapters 3 and 4 
explain how to grace a slide with pictures and clip-art images.

 ✦ Tables: Support your proposal with table data. No one will be able to 
refute you. Book III, Chapter 1 explains how to create tables.
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10 A Whirlwind Tour of PowerPoint

 ✦ Charts: For comparing and presenting data, nothing beats a chart. Book 
III, Chapter 2 explains charts.

 ✦ Diagrams: With diagrams, the audience can literally visualize a rela-
tionship, concept, or idea. Book III, Chapter 3 explains how to create 
diagrams.

 ✦ Shapes and text-box shapes: You can use lines, shapes, and text box 
shapes (shapes with words on them) to illustrate your ideas. Book IV, 
Chapter 1 shows how to draw lines and shapes.

 ✦ Sound and video: Include sound and video to make your presentation a 
feast for the ears and eyes. Book V explains sound and video.

A Whirlwind Tour of PowerPoint
To help you understand what you’re getting into, the rest of this chapter 
provides a whirlwind tour of PowerPoint. It explains what creating a pre-
sentation entails, from inserting the first slide to putting on the finishing 
touches. Better fasten your safety belt.

Creating the slides
After you create a new presentation, your next task is to insert the slides 
(see Book II, Chapter 1). As shown in Figure 1-2, PowerPoint offers many pre-
formatted slide layouts. These layouts are available on the New Slide drop-
down list, the drop-down list you open when you want to insert a slide. Each 
layout is designed for presenting information a certain way.

 

Figure 1-2: 
Adding a 
new slide in 
Slide Sorter 
view.
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